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Conditions and Limitations of Use 
 

 

IMPORTANT: As Hygiena LLC have no control over the specification, state or 
use of any computer equipment on which this software is installed or used, 
the following conditions of use apply. 

 
 

 
End User Licence Agreement 

 
THIS SOFTWARE IS FOR USE WITH THE  

"SystemSURE Plus" AND "systemSURE II" UNITS. 
 

BY INSTALLING, COPYING, OR USING THIS SOFTWARE, YOU 
ACKNOWLEDGE THAT YOU HAVE READ, UNDERSTAND, AND AGREE TO BE 
BOUND BY THE TERMS AND CONDITIONS OF THIS LICENCE AGREEMENT. 

 
YOU MAY FREELY INSTALL AND USE THIS SOFTWARE ON ONE OR MORE 

COMPATIBLE COMPUTER(S) WITHIN YOUR ORGANISATION. 
 

THIS SOFTWARE MAY BE INSTALLED ON A SHARED OR NETWORKED FILE 
SYSTEM OR SERVER. HOWEVER, DUE TO POSSIBLE OPERATING SYSTEM 
INCOMPATIBILITIES, IT CANNOT BE GUARANTEED THAT SUCH MULTI-

USER ACCESS WILL NOT RESULT IN A LOSS OF STORED DATA. 
 

YOU MAY MAKE ONE BACKUP COPY OF THE SOFTWARE INSTALLATION 
DISK, PROVIDED THIS BACKUP COPY IS NOT INSTALLED OR USED ON 

ANY COMPUTER, EXCEPT WHERE THE ORIGINAL INSTALLATION DISK IS 
DAMAGED OR HAS BEEN DESTROYED. 

 
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTIES OF ANY 

KIND EITHER EXPRESSED OR IMPLIED INCLUDING WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 

 
HYGIENA LLC SHALL NOT BE LIABLE FOR ANY LOSS OF PROFIT, LOSS OF 
USE, LOSS OF SOFTWARE, LOSS OF DATA, INTERRUPTION TO BUSINESS, 

NOR FOR INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES OF ANY KIND WHETHER UNDER THIS AGREEMENT OR NOT. 

 
THIS SOFTWARE AND ANY ASSOCIATED DOCUMENTATION REMAINS THE 
PROPERTY OF HYGIENA LLC AT ALL TIMES AND MAY NOT BE COPIED, IN 
PART OR IN FULL, FOR THE PURPOSES OF REDISTRIBUTION OR RESALE 

WITHOUT THE PRIOR WRITTEN PERMISSION OF HYGIENA LLC. 
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1 Introduction 

The SureTrend Data Analysis Software is a standalone test results database and trend 
analysis application, for use with the SystemSURE Plus and systemSURE II units. 
 
The core elements of the SureTrend software are: 
 

SureTrend Software 

 
Results 

Database 

 
Report 

Generator 

  

 
 
 

 

 
User IDs & 
Unit Set-up 

 

 
Report 
Output  

 

 
Review 

 
Print 

 
Share 

 
The key advantages and features of the SureTrend software are: 
 

• Fully standalone application with no need for third-party software such as 
Microsoft Excel or Microsoft Access 

• Direct uploading of test results data from one or more SystemSURE Plus or 
systemSURE II units  

• Storage of uploaded results in to a single contiguous database file, which can 
be protected to prevent accidental or fraudulent manipulation of the data 

• Optional annotation of test results and report output data 
• Fully configurable report output chart and data generation and printing 
• Trend analysis of test results data over specific time periods 
• Program location and threshold set-up and download to individual 

SystemSURE units 
• SystemSURE Plus support for User ID, program location name and sample 

test plan definition and downloading 
• Automatic PC clock time and date synchronisation with the SystemSURE unit 

 
Please refer to the appropriate SystemSURE Operator's Manual for details of the 
SystemSURE Plus and systemSURE II units. 
 
For any other technical assistance, please contact your local distributor. 
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1.1 Installing the SureTrend Software 

 
 

IMPORTANT 
 

Please ensure that you have read and understood the 
“Conditions and Limitations of Use” section at the beginning of 

this manual before continuing any further. 
 

Do not install this software if you are not in agreement 
with the “Conditions and Limitations of Use”. 

 
It is strongly recommended that you read this entire manual 

before installing and running the SureTrend software, as 
some features may need to be configured prior to uploading 

any test results from the SystemSURE unit. 
 

 
The software is installed onto your computer by inserting the CD into your CD-ROM 
drive and following the installation script screen prompts. If the install script does not 
automatically start, open the CD-ROM folder from the My Computer icon on the PC 
desktop and run the Install application. 
 
TIP: You might need to be logged on to your computer as an administrator, or be a 
member of the Administrators group, in order to install the software. 
 
NOTE: If the SureTrend data files are to accessed by multiple users, the software and 
data files should be installed onto the shared file server first, and then additionally 
installed on each local user’s PC. When the installation is complete, each user 
installation of the software should be individually configured to the needs and privileges 
of each user and their computer hardware capabilities. Please refer to section 10 for 
software set-up details. 
 
Once installed, the new software is run by selecting the SureTrend - Data Analysis 
Software shortcut from the Windows start menu: 
 

 
 
A digital version of this User's Manual is also installed and is accessible from the Help 
menu of the SureTrend software. 
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NOTE: This User's Manual is stored in Portable Document Format and requires 
Adobe® PDF Reader to view it. This reader is not supplied with the SureTrend 
software, but is freely available from the Abode web site: www.adobe.com 

 Adobe, Adobe Reader and the Adobe PDF logo are registered trademarks of Adobe Systems Incorporated. 
All Adobe software is subject to its own Terms and Conditions of Use, and is not covered by any licence or 
warrantee agreement with Hygiena LLC. 

 

1.2 Uninstalling the SureTrend Software 

To uninstall the SureTrend software from your PC, use the Add or Remove Programs 
option in the Windows Control Panel. Then select SureTrend Data Analysis Software 
from the list of currently installed programs and follow the on-screen prompts. 
 
NOTE: Please copy off any test results data and set-up files you may wish to keep 
before uninstalling the software. 
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2 General Software Features 

When the SureTrend software is opened (from the Windows start menu), the following 
application screen is displayed:  
 

 

Menu Bar 

 

Toolbar 

 

Navigator 

 

Data Window 

 

Status Bar 

 

 

 
 

2.1 Toolbar Buttons and Menu Bar Options  

The toolbar has the following buttons: 
 

 
 
These toolbar buttons provide shortcuts to commonly used menu bar options:  
 

Menu 
Option 

Toolbar
Button 

Action 
Performed 

Manual 
Section 

File 
Open  Open the selected data file 2.3 

File 
Close  Close the current data file 2.2 

File 
Close All  Close all open data files 2.2 

File 
Save  Save data file changes to disk 2.2.3 

File 
Revert  Discard any changes are reopen the 

previously saved data file  

File 
Synchronise...  

Transfer data between SureTrend 
software and the SystemSURE unit 2.5 

File 
Import...  Import database, reports and unit 

set-up data files from other sites 2.4 

File 
Export...  Export database, reports and unit 

set-up data files to other sites 2.4.1 

File 
Create Archive File  Reduce the size of the Results 

Database by archiving old data 5 

File 
Printer Set-up...  Set-up the printer properties  
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File 
Print Preview  Preview the output prior to printing  

File 
Print...  Print table data or report chart  

File 
Exit  Close the SureTrend software  

Edit 
Cut  Copy and delete selected data 2.2.3 

Edit 
Copy  Copy selected data 2.2.3 

Edit 
Paste  Paste selected data 2.2.3 

Edit 
Delete  Delete selected data or set-up file 2.2.3 

Edit 
Select All  Select all data for copy/cut/paste 2.2.3 

Edit 
Select None  Cancel the data selection 2.2.3 

Edit 
Search...  Search for data 2.2.2 

Edit 
Edit ‘Notes’ Field  Edit the data table 'Notes' field 2.2.3 

Reports 
Create New Report  Create a new report set-up file 6.3 

Reports 
Set-up Report  Modify the existing report set-up file 6.3 

Reports 
Generate Report  Run the selected report 6.1 

Report 
Statistics  Preview statistical data 4.2 

Reports 
Standard Report #1  Run 'Standard Report #1' 6.1 

Reports 
Standard Report #2  Run 'Standard Report #2' 6.1 

Reports 
Standard Report #3  Run 'Standard Report #3' 6.1 

Reports 
Failures Report  Run 'Standard Failures Report' 6.1 

Set-up 
Add New Unit  Add a new SystemSURE unit to the 

SureTrend software 8.1 

Set-up 
Add Test Plan  Add a new Test Plan to the 

SystemSURE unit set-up data 8.4.1 

Set-up 
Delete Test Plan  Remove a new Test Plan from the 

SystemSURE unit set-up data 8.4.1 

Set-up 
Set Unit Clock  Send the PC's clock time and date to 

the SystemSURE unit 10.3 

Set-up 
Password  Set or change the data protection 

password 10.1 

Set-up 
Preferences...  Access the SureTrend software 

configuration options 10 

Help 
User’s Manual  Open this help file 9 

Help  Open the Hygiena Technical Support 9 
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Technical Support... internet page 
Help 
About SureTrend  Display the SureTrend software 

version details  

 
TIP: For consistency, this manual makes specific reference to the menu options (e.g. 
"the Search option from the Edit menu"), however if there is an associated toolbar 
button (e.g. " ") this can be clicked instead. 
 
Also, some options are also available on the right-click context menus, for example: 
 

 
2.2 Navigator and Data Windows 

The Navigator is located on the left-hand-side of the SureTrend application screen, and 
maintains a list of all data windows and open data files: 
 

 
 
When new data files are opened, they are added to the Navigator list. Data files and 
windows can be closed by selecting the Close or Close All option from the File menu. 
 
When a Navigator list item is selected (by clicking to the item name), the associated 
data is displayed in the Data Window area of the application. 
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The data is generally displayed in the form of a table of data records (running down the 
window in rows), with each record consisting of a set of related data fields (arranged 
across the window in columns): 
 

  Record Data Fields   
  D

at
a 

R
ec

or
ds

  
 

 
 
The contents of the data window and the data record fields are specific to each data 
table type. Refer to sections 4 to 8 for further details. 
 
2.2.1 Data Table Sorting 
When the data table file is first opened, it is automatically sorted into ascending order, 
according to the values of the data field in the left-most column. 
 
The table can be sorted by any of the data fields, either in ascending order or 
descending order, by clicking on the appropriate data window column headings: 
 

 
 
For example, clicking on the Date Modified column heading of the Reports window will 
sort the table into ascending order with the oldest report file at the top of the table. 
Whereas, clicking the column heading again will sort the list into descending order with 
the most recently modified file at the top. 
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2.2.2 Selecting Data Records 
To select a single data record, simply click on the table row: 
 

 
 
You can then perform various data functions (such as Copy) by either: selecting the 
menu option from the menu bar; clicking on the toolbar button; or right-clicking on the 
selected data to access the context menu. 
 
To select more than one table record, hold down the Ctrl key on the keyboard and then 
click on each of the rows you wish to select in turn. 
 
To select a range of records, click on the first table row, then hold down the keyboard 
Shift key and click on the last row you wish to select. This will select the first row 
clicked, the last row, and all the rows in between. 
 
You can also use the Search option from the Edit menu to search for and select all 
records that contains the specified text: 
 

 
 
NOTE: The Search option performs a text search on all records and fields and is case 
insensitive (i.e. upper and lower case letters are treated as being the same). 
 
TIP: If the Select all matching records option is not ticked, the Search option will find 
the next matching record after the currently selected record. This can be repeated to 
step through each occurrence of the text in turn. 
 

2.2.3 Data Table Editing 
Where allowed, the user can edit or modify the contents of the data table's record fields 
in several ways: 
 

(a) Most editable data fields can be changed by double-clicking on the field data 
value, and typing-in the new value or selecting one from the drop-down list: 
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(b) Selecting several data rows and then using the right-click menu Edit options 

to change each data fields value in turn: 
 

 
 

TIP: When editing multiple table rows, you will be prompted as to whether 
you wish to apply the same text to all of the selected records. If you 
answer No, the software will step through each selected field in turn. 

 
(c) Selecting one or more data rows and copying (Copy) and pasting (Paste) the 

selected data into a different part of the table. 
 
NOTE: If the data field you are attempting to change is 'edit protected' (see section 
10.1) you will be prompted for a password before the value can be modified. 
 
Refer to sections 4 to 8 for details of which record data fields can be modified and what 
right-click context menu options are available. 
 
TIP: Whenever the data table contents is changed, the window text will turn BLUE to 
indicate that the data file has been modified and needs to be saved by selecting the 
Save option from the File menu. 
 

2.2.4 Exporting Table Data  
To export the entire contents of a data table to Microsoft Excel, perform the following: 
 

(a) Open the data table from the Navigator list. 
(b) Select the Export option from the Files menu. 
(c) Choose a destination filename and folder location. 
(d) Click the Save button. 
(e) The data table will then be converted and saved as an Excel file. This can 

take a while for large tables. 
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NOTE: Due to the limitations of the Microsoft Excel application, only the first 
65535 data records can be exported. Larger tables will be truncated. 

 
Alternatively, to export a smaller section of data from the data table into another 
application, such as Microsoft Word or Microsoft Excel, perform the following: 
 

(a) Select the data rows from the table you wish to export. 
(b) Select the Copy option from the Edit menu to transfer the data (including 

column heading) into the Windows Clipboard. 
(c) Go to your other application and Paste the copied data into the document at 

the appropriate position. 
(d) Edit the pasted data into the desired format and style. 

 
Refer the section 2.4.1 for details of how to export and share data files between other 
SureTrend users. 
 

2.3 Shared Data File Access 

The SureTrend software is designed to allow several computer users to access the 
Results Database, Report Data, User IDs and Unit Set-up Data files at the same time 
(usually via a shared network file server). 
 
However, this can cause an 'access conflict' if two or more users try to view or modify 
the same data file at the same time. This conflict is resolved as follows: 
 

1) The first user to open the data file is given full 'read-write' permission, 
allowing the data to be viewed and modified.  

 
2) Subsequent users who attempt to open the same data file are only given 

restricted 'read-only' permission, allowing the file contents to be viewed but 
not modified. In this case the data window text will turn GREY to indicate that 
the data cannot be edited. 

 
3) Once the first user has closed the data file, one of the other users can gain 

full 'read-write' permission by reopening the data file using the Open option in 
the File menu. If successful, the window text will turn BLACK and the file 
contents can now be edited. 

 
NOTE: If the user does not normally have the authority to modify the data file contents 
(in that, a password is required to alter the data), the file will be initially opened as 'read-
only'. When the user attempts to modify the data, they will be prompted for the 
password and then the file will be reopened with full 'read-write' permissions. 
 
TIP: The Monitor Shared Files set-up option (see section 10.6) can be used to 
automatically check the status of 'read-only' data files to determine whether the data 
has been modified by another user. 
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2.4 Importing and Export Data Files 

As well as allowing multiple users to access a common set of SureTrend data files on a 
local network system, these files can also be exported from one site, emailed (for 
example) to another site, and imported back into the SureTrend software. 
 

2.4.1 Exporting Data Files 
To export an archived data file, a report set-up or output file, or a unit set-up data file, 
perform the following: 
 

(a) Open the appropriate Archived Data, Reports or Unit Set-up Data window 
from the Navigator list. 

(b) Select the file (or files) to be exported from the file table. 
(c) Select the Export option from the File menu. 
(d) Select a destination filename and folder. 
(e) Click the Save button to export the data files as a single output file. 

 
TIP: This can also be used to backup your data files into a single output file, which can 
be reopened at a later date, if need be, and the stored files imported back into the 
software. 
 
To export the Results Database file, perform the following: 
 

(a) Open the Archived Data window from the Navigator list. 
(b) Select the Results Database file from the file table. 
(c) Select the Export option from the File menu. 
(d) Select a destination filename and folder. 
(e) Click the Save button to save the database file as a new exported file. 

 
Refer to section 2.2.4 for details of how to convert and save the Results Database file 
as a Microsoft Excel file. 
 

2.4.2 Importing Data Files 
To import data files from another site or remote user, perform the following: 
 

(a) Select the Import option from the File menu. 
(b) Browse to the folder where the new files are located. 
(c) Select the files to be imported from the file list (using the Ctrl and Shift keys 

to select more than one file at a time if required). 
(d) Click the Open button to read the selected data files into the SureTrend 

software and automatically stored them the appropriate data folders. 
 
TIP: Alternative, it is also possible to drag-and-drop the data files directly into the Main 
Menu window of the SureTrend software. 
 
If the imported file has the same name as an existing data file, you will be prompted to 
supply a new file name. This allows similar files from different sites to be imported 
without overriding the existing files. 
 
TIP: To import files received by email, first save the attachments (to your desktop, say) 
and then import them into the software as detailed above. 
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NOTE: If the data files have been supplied on CD-ROM, they may have read-only file 
properties, and will remain read-only when the files are imported. If this is a problem, 
use Windows Explorer to copy the files to your hard disk, then change the file 
Properties to remove the Read-only attribute, and finally import these files instead. 
 

2.4.3 Importing the dataSURE II Database File 
The database file from the older dataSURE II Data Analysis Software can be imported 
directly into SureTrend to form the basis of new database file. This is achieved as 
follows: 
 

(a) Import the dataSURE II database file in manner described in section 2.4.2, 
giving it a new filename if necessary.  

(b) Open the Archived Data window from the Navigator list. 
(c) Select the dataSURE II database file from the file list. 
(d) Select the Open option from the File menu. 
(e) When prompted as to whether you wish the read the old dataSURE II test 

results data into the Results Database, answer Yes. 
 
NOTE: This can only be done if the SureTrend Results Database is complete empty. 
 

2.5 SystemSURE Unit Communications 

When the Synchronise option is selected from the File menu, the following dialog 
window will appear: 
 

 
 
Connect the serial interface cable (supplied with the unit) between the SystemSURE 
unit and one of the RS232 or USB ports on your PC. Please refer to the SystemSURE 
Operator's Manual for details. 
 
Next, select the Serial Port from the drop-down list. If you do not know which COM port 
you are using, you may have to resort to 'trial-and-error'. Generally: Laptops use COM1; 
Desktops PCs use COM2; and USB-to-RS232 adapters use COM3-COM5. 
 
Finally, switch on the SystemSURE unit and click on the dialog Connect button. 
 
If correctly connected, the establish communications with the SystemSURE unit and 
automatically transfer the unit's results and set-up data, as required. 
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TIP: The software can be configured to automatically connect with the SystemSURE 
unit when the Synchronise option is selected, without the need to click the Connect 
button. See section 10.5 for more details. 
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3 Main Menu 

When the SureTrend software is opened, the Main Menu window is displayed, which 
provides direct access to the primary software functions: 
 

Button Action Section 

 
Upload new test results data from the SystemSURE 
unit and store them in the Results Database 4.1 

 
View the entire Results Database with the most 
recent test results data first 4 

 
Run your Standard Report #1 on the Results 
Database 6 

 
Run the Failures Report on the Results Database 6 

 
Add a new SystemSURE Unit to the SureTrend 
software 8.1 

 
Save all data and exit the SureTrend software - 

 
TIP: The action of the Standard Report and Failures Report buttons can be configured 
via the software Preferences window. See section 10.4 for details. 
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4 Results Database 

The Results Database window displays the contents of the test results database table, 
which maintains a history of every test results uploaded from the SystemSURE units: 
 

 
 
New test results data is uploaded directly from one or more SystemSURE Plus and/or 
systemSURE II units and stored in the Results Database. As each test result is stored 
along with its unit serial number, test time and date, and the sample location, it can be 
positively identified and data trends tracked. 
 
To prevent accidental or fraudulent manipulation of the test results in the database, data 
cannot be directly added, deleted or edited by the user. This protects the integrity of the 
uploaded data and eliminates 'selective amendments' or other ‘data abuse'. 
 
Each individual test result record comprises of the following set of data fields: 
 

Column Field Data 
Index The overall  /  /  result icon and database record index number 
Date The date the test was performed 
Time The time the test was performed 
Unit# The serial number of the SystemSURE unit that performed the test 
User ID The ID of the User the performed the test 
Plan The Test Plan name 
Prog# The unit PROG number used for the test 
Location The Location name associated with the Unit# and Prog# 
Group The Group name associated with the Unit# and Prog# 
Surface The Surface name associated with the Unit# and Prog# 
Test Type The test type: Normal/Repeat Reading/Retested/Retest Result 
Result The overall Pass/Caution/Fail test result 
RLUs The test reading in RLUs 
Lower The lower ( ) program threshold 
Upper The upper ( ) program threshold 
Notes Additional field for optional related comments and notes 

 
The format of the Date and Time fields is defined in the software Preferences window. 
See section 10.3 for details.  
 
The User ID, Plan, Location, Group and Surface can be changed by double-clicking 
on the value you want to change and then either typing the correct name or by selecting 
one from the drop-down list. 
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The Test Type field describes how the test was performed on the SystemSURE Plus 
unit and how the result was derived at: 
 

Test Type Reading Method 

Normal 
A normal Pass ( ), Caution ( ) or Fail ( ) test result, 
whereby the Ultrasnap sample device was placed in the 
unit and read once only. 

Repeat Reading 

A repeat reading Pass, Caution or Fail result, whereby the 
sample device was placed in the unit and multiple reading 
taken by repeatedly pressing the  button without 
removing the sample device. 

Retested A Fail test result that has been subsequently retested and 
marked with the  icon on the SystemSURE Plus display. 

Retest Result The Pass, Caution or Fail result of a retest, that is marked 
with the  icon on the SystemSURE Plus display. 

 
The Notes field can be used to optionally annotate the test result records with additional 
user entered text, as required. Refer to section 2.2.3 for details.  
 
The following right-click menu options are available to the Results Database window: 
 

 

Synchronise: Upload new test results from the SystemSURE unit. 
Statistics: Display statistical data for selected database records. 
Edit 'Notes': Edit the Notes field of the selected records. 
Copy: Copy the selected data to the clipboard. 
Select All: Select all database records. 
Search: Search the database for the specified text. 

 

4.1 Uploading Test Results from the SystemSURE Unit 

Sample test results data is uploaded from the SystemSURE Plus or systemSURE II unit 
and stored in the Results Database file. Please refer to the SystemSURE Operator's 
Manual for details of how to take sample measurements. 
 
WARNING: Please ensure that the associated Unit Set-up Data file has been created 
and fully configured before attempting to upload test results from the SystemSURE unit, 
otherwise a loss of uploaded results data may occur. See section 8 for details. 
 
To upload new test results data from the SystemSURE unit, connect the unit to the PC, 
select the Synchronise option from the File menu and click the Connect button. Refer 
to section 2.5 for further details. 
 
If correctly connected, the new test results will be uploaded from the SystemSURE unit 
and stored in the Results Database. 
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When the upload is complete, you can choose whether or not to erase the uploaded test 
results from the memory of the SystemSURE unit:  
 

 
 
If you choose not to automatically erase the results from the unit, they can be manually 
erased later. Refer to the SystemSURE Operator's Manual for details. 
 
NOTE: The new test results data is automatically sorted into the Results Database in 
chronological (ascending date and time) order. Hence, if you are operating with several 
SystemSURE units, the most recently uploaded data may not always appear at the end 
of the database table, depending on the date the tests were performed. 
 
Column sorting (see section 2.2.1) can therefore be used to sort and view the database 
contents in a more convenient order. For instance, clicking on the Unit# heading group 
the test results by unit serial number, whilst maintaining their chronological order. 
 
Likewise, clicking on the Result column heading once will sort the database in 
ascending order by the test result type, with the oldest Pass result first; clicking on the 
column heading again will sort the database in descending order with the most recent 
Fail result first. This could be useful for quickly reviewing the most recent Fail results 
without the need to specifically set-up and run a report. 
 

4.2 Previewing Statistical Data 

Statistical data can be displayed by selecting a range of database records (see section 
2.2.2) and then selecting the Statistics option from the Reports menu: 
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Each of the selected database records is then analysed and the following overall 
statistical data calculated and displayed: 
 

Statistic Displayed Data Equation 
Tests Total number of tests selected  n  

Passes Percentage and number of Pass 
results %

n
nPASS , PASSn  

Cautions Percentage and number of Caution 
results %

n
nCAUTION , CAUTIONn  

Fails Percentage and number of Fail 
results %

n
nFAIL , FAILn  

Normal Tests Number and percentage of normal 
test results NORMALn , %

n
nNORMAL  

Repeat Readings Number and percentage of repeat 
readings REPEATn , %

n
nREPEAT  

Fails Retested Number and percentage of failed 
results that have been retested FAILn , %

n
nFAIL  

Retest Results Number and percentage of retest 
results RETESTn , %

n
nRETEST  

Minimum Minimum RLUs reading MINx  

Average Average RLUs reading 
n

x
x ∑=  

Maximum Maximum RLUs reading MAXx  

SD 
Standard Deviation 
(reports 0.0 if 2<n ) 

( )
( )1

2

−

−∑
nn

xx
 

 
The Preview Chart also displays this statistic data in one of three graphically forms: 
 

 Results  

 

Green: Percentage Passes 
Yellow: Percentage Cautions 
Red: Percentage Fails 

 Test Types  

 

Blue: Number of Normal Tests 
Purple: Number of Repeat Readings 
Red: Number of Failed Test Retests 
Orange: Number of Retests Performed 

 RLUs  

 

Blue: RLUs 
Grey: Average RLUs 
Scale: Minimum RLUs to Maximum RLUs 

 
TIP: When you move the mouse pointer over the Preview Chart, the value of the pie 
segment or line point under the pointer is displayed. For example: . 
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5 Archived Data 

The Archived Data window provides a list of all database archive files and imported 
dataSURE II Database files: 
 

 
 
TIP: This list also includes the actual SureTrend Results Database file itself. This allows 
the database file to be exported and shared with other sites. See section 2.4. 
 

5.1 Creating a New Database Archive File 

As the Results Database stores every test result ever uploaded from the SystemSURE 
units, it can become very large and potentially unmanageable. 
 
Hence, older data can be removed from the database by selecting the Results 
Database window from the Navigator list, and then selecting the Create Archive File 
option from the File menu. This will bring up the Archive Wizard: 
 

 

The wizard will then guide you through the simple 
steps required to archive data in the main results 
database. 
 
NOTE: Once test results data has been remove 
from the main database it can only be accessed 
by opening the associated archive file from the 
Archived Data window. See section 5.2 below 
for further details. 

  
  

 

Step 1: Select the data archiving method. 

 Option 1: Select this option to archive all test 
results from the beginning of the database up to 
(and including) the date you specify. 

 Option 2: Select this option to archive all of 
the test results data and leave the database 
completely empty. 
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Step 2: Select the archive file comment. 

You may include an additional text comment, 
which will appear in the Notes column on the 
Archived Data window. 

Then click the Finish button to save the new set-
up data. 

 

5.2 Opening an Archived Data File 

To reopen an Archived database file, simply select the file from the Archived Data list, 
and then select the Open option from the Files menu. 
 
The archived data will then be read back into the Results Database, and displayed with 
its record result icons greyed-out ( ) to indicate that it is archive data – which is 
automatically removed when the Results Database is next opened. 
 
The included archive data can now be re-analysed using the report generator. 
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6 Report Generator 

The Reports window lists all the report set-up files and report output data files: 
 

 
 
The report files types are distinguished by file icon and background colour: 
 

File Icon File Type Background Colour 

 Report Set-up File White 

 Report Output Data Pale blue 
 
The report generator allows standard reports to be defined and regularly run, to produce 
consistently formatted report charts and data, which can be printed or stored for review 
at a later date. 
 
These reports can also include trending analysis, allowing several consecutive time 
periods to be compared on a single report chart. Refer section 6.4 for details on data 
trending. 
 
The following right-click menu options are available for the Reports window: 
 

 

Set-up Report: Modify the selected report set-up file ( ) 
Generate Report: Create a new report output file from the 
selected report set-up file ( → ) 
Open: Open the selected report output data file ( ) 
Refresh: Refresh the report file list. 
Edit 'Notes': Edit the 'Notes' field of the selected files. 
Copy: Copy the selected data to the clipboard. 
Delete: Permanently delete the selected report file. 
Select All: Select all report files. 
Search: Search the list for the specified text. 

 
TIP: The SureTrend software is pre-loaded with numerous typical report types. These 
can be used as is; copied and modified; or new reports set-up. See sections 6.1 and 6.3 
for details. 
 

6.1 Generating a New Report Output File 

A new report output data file is generated by selecting the required report set-up file ( ) 
from the Reports window file list, and then selecting the Generate Report option from 
the Reports menu. 
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TIP: The report toolbar buttons ( , ,  or ) can also be used. Refer to section 10.4 
for details of how to configure these buttons to select your four most frequently used 
reports. 
 
This will bring up the Report Output Wizard: 
 

The wizard will then guide you through the steps 
required to run the report and generate the output 
data file. 
 
NOTE: Some reports do not need to perform all 
of the wizard steps, as the required input data is 
already pre-defined in the report set-up file or is 
not relevant to the type of report. In this case the 
unneeded steps are automatically bypassed.  

  
  

Step 1: Select the report name. 

Enter the name of the new report output data file. 
This name must be unique to the Reports list. 

 Do Not Save Data: Tick this option if you do 
not wish to save the output data to disk. This will 
save disk space but does prohibits the report 
output data from being reviewed at a later date 
without generating a new report. 

  
  

Step 2: Enter the report time period. 

 Report Time Period: Select the report time 
period from the drop-down list. 

 Data Trending: Select the number of report 
data trending periods required. 

 Start and End Date: Select the start and/or 
end date of the total time period, as required. 

See below for further details. 

 
The possible report time periods and durations are as follows: 

 
Time Period Period Duration Data Trending Periods 

None 100 years (all data) None (1 period) 
Specific Set by Start and End date None (1 period) 

Daily 1 day None (1) or 2 to 14 periods 
Weekly 7 days None (1) or 2 to 14 periods 
Monthly 1 calendar month None (1) or 2 to 14 periods 

Quarterly 3 calendar months None (1) or 2 to 14 periods 
Yearly 1 calendar year None (1) or 2 to 14 periods 
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Generally, the End Date of the final time period is specified (e.g. "Week Ending") and 
the Start Date is automatically calculated (from the Time Period multiplied by the 
number of Data Trending periods). Refer to section 6.4 for details of data trending. 
 
NOTE: Some reports may also be set-up with a predefined Time Period or number of 
Data Trending periods, in which case these values are pre-selected and cannot be 
altered. 
 
  

Step 3: Enter report specific data. 

If necessary, additional report-specific data may 
be required. This will normally be a single value 
(such as a Location), but could also be a range of 
values (such as a particular Prog# range). 

 Value: Type in the required value or select one 
from the drop-down list. 

If more that one set of values are required, this 
step is repeated for each set in turn. 

  
  

Step 4: Select the report output file comment. 

You may include an additional text comment, 
which will appear in the Notes column on the 
Reports window. 

NOTE: This is not required if the Do Not Save 
Data box is ticked in wizard Step 1. 

Then click the Finish button to generate the new 
report output data. See section 6.2 for details. 

 
NOTE: Depending on the size of the Results database and the complexity of the report 
set-up, the report generator may take between a few seconds and a couple of minutes 
to filter, analysis and sort the results data to create the report output data. 
 

6.2 Reviewing and Customising the Report Output 

Having generated a report, it can reopened by selecting the report output data file ( ) 
from the list on the Reports window and then selecting the Open option from the Files 
menu. 
 
The report output file is then added to the Navigator list as a sub-item under Reports, 
and has three data elements: 
 

 Additional Notes 

Report Chart 

 Report Data table 
 



24 
 

6.2.1 Additional Notes Editor 
Clicking on the report output name in the Navigator list, displays the report Additional 
Notes text editor window: 
 

 
 
This simple text editor can be used to add any additional text information to the report 
output file, and printed if necessary. 
 

6.2.2 Report Chart 
Clicking on the Report Chart item in the Navigator list, displays the report output chart 
window: 
 

 
 
When you move the mouse pointer over the Report Chart window graph area, the 
value of the data point under the pointer is displayed: 
 

 
 
TIP: If you double-click on the data point, you will be taken to the corresponding data 
row in the Report Data window - which in turn can be double-clicked to display the 
associated Statistical data. 
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Right-clicking on the chart area provides the following context menu options: 
 

Copy: Copy the chart bitmap to the clipboard. 
Legends: Show/hide the legends box. 
Markers: Show/hide line graph point markers. 
Annotation: Show/hide the data value boxes. 
Trend Lines: Show/hide line graph least-squares line fit. 
Properties: Open the chart customisation wizard. 

 
The chart appearance can be changed by selecting the Properties option from the 
right-click context menu: 
 

Modify report chart details... 
This mini-wizard allows customisation of: 

• The chart style 
• Chart title 
• Y-axis and X-axis labels 
• Y-axis traces, colours and names 
• Displaying of Y-data values. 

Refer to section 6.3 step 3 for full details of the 
available options. 

 

6.2.3 Report Data Table 
Clicking on the Report Data item in the Navigator list, displays the report data table 
window: 
 

 
 
Right-clicking on the table data provides the following context menu options: 
 

Statistics: Display statistical data for selected rows. 
Export: Export the data table to a Microsoft Excel file. 
Copy: Copy the select data to the clipboard. 
Select All: Select all table rows. 
Search: Search the table for the specified text. 
Properties: Open the data table customisation wizard. 
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TIP: For statistical data, where each output row that was generated from the analysis 
and combination of several database records, double-clicking on the table row will open 
the Statistics dialog window (see section 4.2) with a graph showing each of the original 
database data points. 
 
TIP: Using the Export option from the File menu allows the entire contents of the data 
table to be saved as a Microsoft Excel file. See section 2.4.1 for details. 
 
The format of the table's rows and columns are pre-defined by the report set-up file, 
according to the desired report data style and contents. This can be customised by 
selecting the Properties option from the right-click context menu: 
 

Modify report data table... 
This mini-wizard allows customisation of: 

• Which data Fields are included 
• The arrangement of the columns 
• Column data sorting 

Refer to section 6.3 step 4 for full details of the 
available options. 

 

6.3 Creating a New Report Set-up File 

To create a completely new report set-up file, select the Create New Report options 
from the Reports menu. Otherwise, to modify an existing Report Set-up file, select the 
file from the Reports list and then select the Set-up Report option from the Reports 
menu.  
 
This will bring up the Report Set-up Wizard: 
 

The wizard will then guide you through the steps 
required to set-up a new report or change an 
existing set-up file. 
 
NOTE: Wizard Steps 2, 3 and 4 are only required 
if the Advanced Set-up box is ticked in wizard 
Step 1, otherwise these set-up parameters and 
automatically configured and wizard steps are 
bypassed.  
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Step 1: Select the report name and style. 

Enter the name of the new report set-up data file. 
This name must be unique to the Reports list. 

 The other set-up parameters define: the time 
period and data trending of the report; how the 
database results are filtered and analysed; and 
style of the report chart and data table. 

See below for more details. 

 
NOTE: Some combinations of these set-up parameters can produce peculiar or 
meaningless report charts, or may fail to create any output data at all. 
 
The Report Period defines the time period of the report, such that only those database 
test results that fall within this period are included in the report analysis and output: 
 

Report Period Period Duration 

None The start and end dates are those of all the 
data in the test Results Database 

Specific The start and end dates are defined by the 
user when the report is run 

Daily 1 day 
Weekly 7 days 
Monthly 1 calendar month 

Quarterly 3 calendar months 
Yearly 1 calendar year 

Custom... Any of the above (selected by the user 
when the report is run) 

 
For Daily, Weekly, Monthly, Quarterly, Yearly and Custom time periods (above), a 
number of consecutive Data Trending periods can also be set specified, as follows: 
 

Data Trending Allowable Trending Periods 
None No trending (single Time Period only) 

2 to 14 

Between 2 and 14 consecutive Time 
Periods, allowing report durations such as: 

• 5, 7 or 14 days 
• 2, 4, 8 or 12 weeks 
• 3, 4, 6 or 12 months 
• 2 or 4 quarters 

Custom... Any of the above (selected by the user 
when the report is run) 

 
Refer to section 6.4 for further information about data trending. 
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The Test Results Selection option defines the primary database test results filtering: 
 

Selection Database Filtering Performed 
All test Results None 

Passes only 
Cautions only 

Fails only 

Data records are selected according to the 
test Result field: Pass, Caution or Fail  

Fails and Retests 
Data records are selected according to the 
Test Type field: Retested or Retest Result 
(see section 4 for Test Type descriptions) 

 
The Specific Data Selection option defines whether the user is required to select a 
specific data field value when the report is run: 
 

Specific Data Database Filtering Performed 
None None (no additional filtering performed) 
Unit# 

User ID 
Test Plan 

Prog# 
Location 
Surface 
Group 

When the report is run, the user must 
select a value for the specified database 
record field. 

Only those database test results that relate 
to the selected field value will be included 
in the report analysis and output.  

 
The Data Analysis option defines how the filtered data is analysed (for each data 
trending period) to produce a more concise set of report output data values: 
 

Data Analysis Chart X-Axis Data 
None Chronologically (all filtered data is output) 

Summary The data is combined into a single set of 
statistical values (see section 4.2) 

Time of Day Hour: 12AM, 1AM, 2AM, 3AM, etc  
Date Individual dates (chronologically) 

Day of Week Day: Sun, Mon, Tue, Wed, Thu, Fri, Sat 
Week Calendar week date (chronologically) 
Month Calendar month date (chronologically) 
Unit# 

User ID 
Test Plan 

Prog# 
Location 
Surface 
Group 

Unit serial number 
User ID name 
Test Plan name 
Prog# number 
Location name 
Surface name 
Group name  

Test Type 
Result 

Test Type (see section 4) 
Result type (Passes, Cautions and Fails) 

 
 
 
The Report Chart Data option defines what data appears on the Y-axis of the Report 
Chart, and the style of chart (see step 3): 
 

Chart Data Style Y-Axis Data  
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Tests Performed Bar Number of test results 
Passes Bar Number of Pass results 

Cautions Bar Number of Caution results 
Fails Bar Number of Fail results 

Results Pie 
Number of Pass results 
Number of Caution results 
Number of Fail results 

Percentage Results 
Pie 
or 

Stacked 

Percentage of Pass results 
Percentage of Caution results 
Percentage of Fail results 

Test Types 
Pie 
or 

Bar 

Number of Normal test result 
Number of Repeat Reading results 
Number of Retested Fail results 
Number of Retest results 

RLUs Line RLUs (or average) 

RLUs with thresholds Line 
RLUs (or average) 
Lower thresholds (or average) 
Lower thresholds (or average) 

Min / Average / Max Linked 
Minimum RLUs 
Average RLUs 
Maximum RLUs 

 
The Report Data Table options define what data is included in the Report Data table: 
 

Table Type Data Fields Included 
Chart Data As per chart output traces (see below) 

Database Data All database fields (see section 4) 
Statistical All statistical data values (see section 4.2) 
Custom As defined by wizard Step 4 (see below) 

 
 Advanced Set-up: Normally the set-up options for wizard Steps 2, 3 and 4 are 

automatically pre-defined by the options specified in Step 1. However, ticking this option 
allows those setting to be overridden and more tailored report output to be defined. 
 
  
  

Step 2: Define custom data selection. 

Field Filtering: This specifies how the database 
records are filtered. See below for details. 

Remove: Deletes the selected filter condition. 

Modify: Opens the Filter Criteria definition 
window for the selected database field. 

See below for further details. 

 
The Filter Conditions list shows the database Field (see section 4) and the associated 
Filtering condition. 
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The filter condition can be modified by double-clicking on the required field row, or by 
selecting the row and clicking the Modify button. This brings up the specific Filter 
Criteria definition window: 
 

 
 
The Filter Criteria table has the following field and button options: 
 

Field/Option Purpose 
Condition The comparison to be made when filtering the data (see below) 

Custom  No:  The Value (and Range) is pre-define by this condition 
 Yes: The Value is specified by the user when the report is run 

Value The value against which the data is compared 
Range The limit value against which data is compared 
Remove Remove the selected filter criteria 
New Add a new filter criteria 
Exclude... Exclude (rather than include) all data which matches this filter 
OK Accept any changes made to the filter definition and exit 
Cancel Discard any changes made to the filter definition and exit 

 
The Condition defines how the database record field data is compared against the 
Value and Range values. The available conditions depend upon the database Field 
type: 

 
Field Value Conditions Range 
Index Equals / Not equals / Less than / Greater than In the range 
Date Equals / Not equals / Before / After Between 
Time Equals / Not equals / Before / After Between 
Unit# Equals / Not equals / Less than / Greater than In the range 
User ID Equals / Not equals / Contains  
Plan Equals / Not equals / Contains  
Prog# Equals / Not equals / Less than / Greater than In the range 
Location Equals / Not equals / Contains  
Group Equals / Not equals / Contains  
Surface Equals / Not equals / Contains  
Test Type Equals / Not equals  
Result Equals / Not equals  
RLUs Equals / Not equals / Less than / Greater than In the range 
Lower Equals / Not equals / Less than / Greater than In the range 
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Upper Equals / Not equals / Less than / Greater than In the range 
Notes Equals / Not equals / Contains  

 
TIP: Time ranges can be specified such that the first Value is later then the second 
value in the Range to include the midnight rollover. For example: Between 17:00 and 
8:30. 
 
To add a new filter Condition, click on the New button, select the Condition type from 
the drop-down list, then enter the Value (and Range, if applicable). 
 
TIP: For Custom values (i.e. data that must be specifically entered by the user when the 
report is run - see section 6.1 step 3), use the default data Values and then double-click 
on the Custom column value to change it from No to Yes. 
 
NOTE: All dates and times must be entered in the format specified by the Time and 
Date Format in the software Preferences window (see section 10.3). 
 
The Exclude all matching data option can be useful if you want to exclude specific test 
results from your analysis. For example, if you have QC test results which all have the 
letters "QC" in the Group name, you can set-up the filter to "Exclude all data for Groups 
containing QC": 
 

 
 
If more than one Condition is defined, a logical OR is performed. For example, the 
following would be read as "Before 1/02/2007; OR Between 1/04/2007 and 30/04/2007; 
OR After 31/05/2007": 
 

 
 
Conversely, when more than one Field Filters are defined, a logical AND is performed. 
For example, the following would be read as "Between 1/01/2004 and 21/12/2004; AND 
Between 9:00 and 17:00": 
 

 
 
  

Step 3: Select report chart details. 

 Chart Style: Selects the chart type: Line, Bar 
or Pie. See below for examples. 

Title and Text: Optional text for the chart title, 
and the x-axis and y-axis labels.  

Chart Data: Selects the chart data, colours and 
legend names. See below for full details. 

 Display Data: Tick this option to annotate the 
chart with all of the chart y-axis data values. 
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The Chart Style selects the way in which the data is presented on the chart: 
 

Example Chart Style and Data 

 
None: 

No chart is generated 

 

Line: 

Related data points horizontal joined by lines 

 

Linked: 

Related data points linked by vertical lines 

 

Bar:  
Related bars, grouped side-by-side 

 

Stacked Bar: 
Related bars, stacked on top of each other 

 

Pie: 

Related pie segments in one pie 

 
The x-axis type and data is pre-determined by the Data Analysis option in wizard step 1 
above. 
 
The chart y-axis data series are defined by the Chart Data list, which allows the chart y-
axis data fields, colours and legend text to be selected and customised. This is done by 
right-clicking on the required list item and then selecting the appropriate option from the 
following context menu: 
 

 

Field Name: This is the data table field name. 
Visible: Show/hide the selected data series. 
Edit Text: Edit the data series legend name. 
Change Colour: Select the colour of the data series. 
Restore: Reset the series name and colour settings. 
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Step 4: Select the report data table contents. 

Field Sorting: This defines which data Fields are 
including in the Report Data table, the order in 
which they appear, and how each column is to 
sorted. See below for details. 

 Transpose Table: Tick this option to swap-
over the data table rows and columns - thus 
turning a short-wide table into a long-thin table. 

 

 
The data fields are displayed in the Report Data table in the order they are listed in the 
selection table (see above). To change the order of the columns, select a field from the 
list and then use the Move Up and Move Down buttons to reposition the column within 
the table.  
 
Use the tick box next to the Field name to add or remove it from the data table. 
 
The Sorting method defines the way in which the Field data is sorted. This is changed 
by selecting the field row, clicking the Sorting button, and then selecting the new sorting 
method from the drop-down list: 
 

Sorting Method Data Order 

None As defined by the Data Analysis setting 
(see wizard step 1 above) 

Ascending order (0-9, A-Z) Lowest values first 
Descending order (Z-A, 9-0) Highest values first 

 
  

Step 5: Select the report set-up file comment. 

You may include an additional text comment, 
which will appear in the Notes column on the 
Reports window. 

 Run Trial Report: Tick this option to tryout the 
new report set-up by running a trail report without 
saving the report output data. 

Then click the Finish button to save the new 
report set-up file to disk. 

6.4 Report Data Trending 

The report can be set-up to include data trending, whereby the report output data for the 
specified report Time Period is compared against two or more previously time periods 
of the same time span, and displayed on the same chart. 
 
For example: The previous five days worth of Pass, Caution and Fail test results can be 
directly compared against each other by creating a report with the following settings: 
 

Report Period: Daily Report 
Data Trending: 5 Periods 

Test Result Selection: All Test Data 
Specific Data Selection: None (All data) 
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Data Analysis: Summary (Combined) 
Report Chart Style: Percentage Results 
Report Data Table: Statistical 

 
The overall duration of the report is determined as the Report Period interval multiplied 
by the number of Data Trending periods. In this case "Daily" times "5" = "5 Days". 
 
Running this report would produce typical Report Charts such as: 
 

   
Bar Stacked Pie 

 
The five data trending periods are represented on the chart as [A], [B], [C], [D] and [E].  
 
TIP: The period colours are slightly graduated, with the most recent data [A] appearing 
the lightest and brightest, and the oldest data [E] appearing the dullest. 
 
The associated output data table for this report would be: 
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7 User IDs 

The User IDs window displays the table of up to 50 User names, which can be stored in 
the SystemSURE Plus unit: 
 

 
 
The single User IDs list is common to all of the SystemSURE Plus units that have been 
added to the SureTrend software. Hence, if you change the User ID list, you should 
download it to all of your units. 
 
NOTE: User IDs are not support by the systemSURE II unit. 
 
The User ID field is limited to 16 characters, as this is the name what is displayed on 
the SystemSURE Plus screen. Please refer to the SystemSURE Plus Operator's 
Manual for detail of how to select the User ID on the unit. 
 
TIP: If longer user names are required, you could use the User ID field for the user's 
Initials and the Notes field to store their full name. 
 
To add or change a single User ID, simply double-click on the required cell and type in 
the new name or select one from the drop-down list. 
 
To add or change several User IDs, you can select a range of rows and then select the 
Edit User ID option from the right-click context menu: 
 

 

Synchronise: Download the User IDs list to the SystemSURE unit. 
Edit User ID: Edit the User ID field of the selected rows. 
Edit 'Notes': Edit the Notes field of the selected rows. 
Copy: Copy the selected data to the clipboard. 
Delete: Remove the selected User IDs. 
Select All: Select all User ID rows. 
Search: Search the User ID list for the specified text. 
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8 Unit Set-up Data 

The Unit Set-up Data window provides a list of unit set-up data files, one for each 
SystemSURE unit added to the SureTrend software: 
 

 
 
Each Unit Set-up Data file consists of a set of up to 251 Program Locations and Result 
Thresholds, plus up to 20 associated Test Plans. 
 
To modify the set-up data for a particular unit, simply double-click on the Unit# in the 
Title column to open the data file. Refer to section 8.3 for further details. 
 
TIP: The file list can be sorted by clicking on the appropriate column header. See 
section 2.2.1 for details. 
 
If the Unit# is displayed in RED text, it indicates that the set-up data stored in the 
associated SystemSURE Unit is now out-of-date, and can be updated by right-clicking 
on the Unit# and then selecting the Synchronise option from the context menu: 
 

 

Add New Unit: Create a new unit set-up file (see section 8.1). 
Open: Open the selected unit set-up data file. 
Synchronise: Write the set-up data to the SystemSURE unit. 
Refresh: Refresh the Unit Set-up Data file list. 
Edit 'Notes': Edit the Notes field of the selected set-up file. 
Copy: Copy the selected data to the clipboard. 
Delete: Erase the selected set-up file. 
Select All: Select all unit set-up files. 
Search: Search the table for the specified text. 
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8.1 Adding a New Unit 

To add a new Unit Set-up Data file to the SureTrend software, select the Add New 
Unit option from the Set-up menu. This will bring up the New Unit Wizard: 
 

The wizard will then guide you through the steps 
required to add a new SystemSURE Plus or 
systemSURE II unit. 
 
NOTE: To add a new unit from data files already 
supplied to you on CD-ROM or by e-mail, click 
the Import... button at the bottom of the dialog 
window, and then refer to section 2.4 for further 
details. 

  
  

Step 1: Select the unit set-up method. 

 Option 1: Select this option to automatically 
read the new unit's serial number and set-up data 
by connecting the unit to the PC's serial port and 
clicking the Next > button. 

 Option 2: Select this option if you wish to 
manually specify the unit serial number and 
model type, or copy the set-up data from an 
existing unit. 

 
TIP: To add a unit that has already been set-up with Program data (such as an older 
systemSURE II unit), select Option 1 to automatically upload the set-up data from the 
unit. Alternatively, to duplicate the set-up data of an existing unit, select Option 2, enter 
the New Unit#, and the select the Existing Unit# from the drop-down list. 

 
  

Step 2: Select the set-up file comment. 

You may include an additional text comment, 
which will appear in the Notes column on the 
Unit Set-up Data window. 

Then click the Finish button to save the new set-
up data. 

 
Depending on the model type, the unit will have the following storage capabilities: 
 

Storage Feature SystemSURE Plus systemSURE II 
User IDs 50 users Not supported 
Program Locations 251 (0-250) 100 (0-99) 
Location Names 20 characters max Not supported 
Test Plans 20 plans Not supported 
Results Memory 2000 tests 500 tests 
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8.2 Writing the Set-up Data to the SystemSURE Unit 

To download the Unit Set-up Data to the SystemSURE unit, open the Unit Set-up Data 
file (see section 8.3) and select the Synchronise option from the File menu. Refer to 
section 2.5 for further connection details. 
 
The software will then download the following unit set-up data to the SystemSURE unit, 
depending on its model type and capabilities: 
 

Set-up Data SystemSURE Plus systemSURE II 
User IDs   
Location Names   
Program Thresholds   
Test Plans   

 
WARNING: This will overwrite all of the set-up parameters currently stored in the 
SystemSURE unit. Once overwritten, the old values cannot be recovered. 
 

8.3 Program Locations and Result Thresholds 

For each SystemSURE Unit, the software maintains a table of programmable sample 
locations and associated test result thresholds and group and surface names.  
 
When you open a Unit# data file from the Unit Set-up Data window (see 8 for details), 
the unit’s Program Data table is displayed: 
 

 
 
Each table row represents a different Prog# location, and has the following data fields: 
 

Column Data Field 
Prog#  The PROG number, as used on the SystemSURE unit. Refer to the 

SystemSURE Operator's Manual for details. 
Location  The location name (of up to 50 characters) associated with the PROG 

number. This name will appear in the database record listing when 
new test results are uploaded from the SystemSURE unit. Refer to 
section 4.1. NOTE: On the SystemSURE Plus, the first 20 characters 
of the location name are also displayed on the unit's screen. 

Group An optional group name (of up to 50 characters) which can be used to 
categorise the location into a further sub/super group. This name also 
appears in the database record listing when new test results are 
uploaded from the SystemSURE unit. Refer to section 4.1. 
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Surface An optional surface name or type (of up to 50 characters) which can 
be used to further categorise the location. This name also appears in 
the database record listing when new test results are uploaded from 
the SystemSURE unit. Refer to section 4.1. 

Lower  The program lower ( ) threshold, as defined on the SystemSURE 
unit. This data is sent to the SystemSURE unit to define its 
programmable result thresholds. Refer to section 8.2 

Upper  The program upper ( ) threshold, as defined on the SystemSURE 
unit. This data is sent to the SystemSURE unit to define its 
programmable result thresholds. Refer to section 8.2 

Notes Additional comments text, as required. 
 
The value of program Location, Group and Surface names, and the Lower and Upper 
threshold values are all editable. See section 2.2.3 for additional information. 
 
TIP: Prog#0 has a special function, whereby its Lower and Upper threshold values are 
used as the default values when setting-up all of the other Prog# thresholds. Thus, 
setting Prog#0 with your typical threshold values may save time when setting-up the 
other program locations that have similar threshold values. 
 
NOTE: Please refer to the SystemSURE Operator's Manual for details of how the 
Programmable Result Thresholds are used on the unit, and how they are applied to the 
sample test RLU reading to give an over all Pass, Caution or Fail result. 
 
The following right-click context menu options are available: 
 

 

Synchronise: Write the set-up data to the SystemSURE unit. 
Add New Test Plan: Add a new test plan (see section 8.4.1). 
Edit Data: Edit all of the data fields in the selected Prog#s. 
Edit 'Notes': Edit the Notes field of the selected Prog#s. 
Copy: Copy the selected data to the clipboard. 
Paste: Paste the copied data back into the data table. 
Delete: Erase the contents of the selected Prog#s. 
Select All: Select all Prog# rows. 
Search: Search the table for the specified text. 

 
NOTE: If a program Location name, or Lower or Upper threshold value is changed, 
the new set-up data must be written back to the SystemSURE unit to keep it up-to-date 
(see section 8.2). Hence, the program data table is displayed with RED text to warn you 
that the data held on the associated unit is now out-of-date.  
 

8.3.1 Advanced Copy and Paste Functions 
The Edit menu allows the program data to be copied and pasted, enabling initial default 
values to be quickly set-up or the same set-up values to be duplicated across several 
units. 
 
To copy a complete row of data, select the row by clicking on it, then select the Copy 
option from the Edit menu. 
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TIP: Several rows can be selected by holding down the Ctrl key and clicking individual 
additional rows, or by holding down the Shift key and clicking a range of rows. Refer to 
section 2.2.2 for details. 
 
To paste the copied data back into the table, select either a single row, several rows or 
all rows, and then select the Paste option from the Edit menu. 
 
Some typical copy and paste operations are: 
 

Operation Copy/Paste Sequence 
Copy a single row of program data to 
another location. 

(1) Select row to be copied 
(2) Select the Copy option 
(3) Select row to be replaced 
(4) Select the Paste option 

Duplicate a single row of data to all 
other data rows in the table. 
 

(1) Select row to be copied 
(2) Select the Copy option 
(3) Select the Select All option 
(4) Select the Paste option 

Copy several rows of program data to 
another location. Note: The copy and 
paste selections must both be the same 
size. 

(1) Select rows to be copied 
(2) Select the Copy option 
(3) Select rows to be replaced 
(4) Select the Paste option 

Duplicate one unit's program data to 
another unit. 

(1) Open the Unit# to be copied 
(2) Select the Select All option 
(3) Select the Copy option 
(4) Open the Unit# to be replaced 
(5) Select the Select All option 
(6) Select the Paste option 

 

8.4 Sample Test Plans 

The SystemSURE Plus unit can be programmed with up to 20 individual sample Test 
Plans, each consisting of a sequence of up to 251 program locations, listed in the order 
in which they would normally be tested. 
 
NOTE: Test Plans are not supported by the systemSURE II unit. 
 
A new unit set-up file initially contains no associated test plan data. Each test plan must 
be added and configured using the Add New Test Plan option from the Set-up menu 
(see section 8.4.1). 
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As each new test plan is added to the unit, it is listed under the associated Unit# 
program data in the Navigator list: 
 

 
 
NOTE: The Test Plan sequence table stores a list of Prog#s only. The Location, Group 
and Surface names associated with each Prog# are shown purely for reference and 
cannot be directly edited, as they are common to all Test Plans for a particular unit.  
 
Refer to section 8.4.2 for details of how to modify the test plan Prog# sequence list. 
 
The following right-click context menu options are available: 
 

 

Synchronise: Download the set-up data to the SystemSURE unit. 
Cut: Move the selected test plan steps to the clipboard. 
Copy: Copy the selected test plan steps to the clipboard. 
Paste: Insert the copied/cut test plan steps at the selected point. 
Delete: Remove the selected test plan steps. 
Select All: Select all test plan steps. 
Search: Search the list for the specified text. 

 

8.4.1 Adding a New Test Plan 
The SystemSURE Plus unit can store up to 20 individual Test Plans (numbered Plan# 1 
to 20), each of up to 251 program locations steps. 
 
To add a new test plan to the unit, select the Add Test Plan option from the Set-up 
menu. This will bring up the Test Plan Wizard: 
 

The wizard will then guide you through the steps 
required to add a new test plan to the unit. 
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Step 1: Select the new plan name. 

First enter the name of the new test plan, which 
must be unique to that unit. 

This is the name that will appear on the 
SystemSURE Plus display when selecting the 
Test Plan. 

 

 

  
  

Step 2: Select the initial plan data. 

 Option 1: Select this option to create a new 
empty test plan to which program locations can 
be added later. 

 Option 2: Select this option to create a new 
test plan with all the unit program locations pre-
selected. 

 Option 3: Select this option to create a copy of 
an existing test plan that can then be modified. 

  
  

Step 3: Select the initial program locations. 

Finally the program list can be modified: locations 
added, removed and reordered. 

Then click the Finish button to save the new test 
plan data. 

NOTE: The test plan can be further modified 
later. See section 8.4.2 below for details. 

 

8.4.2 Changing an Existing Test Plan 
The test plan data table contents cannot be directly edited, as it simply stores a list of 
Prog#s. The associated Location, Group and Surface details are as defined in the 
Program data list for the associated Prog#. Refer to section 8.4.2 for details. 
 
WARNING: You should always finish setting-up all of the program data before starting 
to define the test plan sequences.  This is important as each test plan is linked directly 
back to the program data table. 
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A test plan can be modified as follows: 
 

Required Action  Steps Performed 
Add new program locations to 
the test plan sequence 

 (a) Select the Unit# window from the Navigator. 
(b) Select required Prog# locations 
(c) Select the Copy option from the Edit menu. 
(d) Select test Plan# window from the Navigator. 
(e) Select the position in the list where you wish to 

place the new locations. 
(f) Select the Paste option from the Edit menu. 

Delete program locations from 
the test plan sequence 

 (a) Select test Plan# window from the Navigator. 
(b) Select the Prog# locations you wish to remove 

from the list. 
(c) Select the Delete option from the Edit menu. 

Change the order in with 
program location appear in 
the test plan sequence 

 (a) Select test Plan# window from the Navigator. 
(b) Select the Prog# locations you wish to move. 
(c) Select the Cut option from the Edit menu. 
(g) Select the position in the list where you wish to 

place the removed locations. 
(d) Select the Paste option from the Edit menu. 

  

8.4.3 Renaming or Deleting a Test Plan 
To change the name of a Test Plan, right-click on the plan name in the Navigator list, 
then select the Rename option and type in the new test plan name: 
 

 
 
Likewise, to delete a Test Plan from the unit set-up data, right-click on the plan name in 
the Navigator list and select the Delete option: 
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9 Technical Support 

The Technical Support window provides direct access to Hygiena’s online Technical 
Support and Documentation Internet pages. 
 
NOTE: This feature requires an active Internet connection. 
 
Whenever the Technical Support window is selected, the following standard Internet 
Explorer toolbar buttons become available instead: 
 

Button  Action 

  Back 

  Forward 

  Go back to Technical Support home page 

  Print page 

  Refresh page 

  Stop 

  Display the SureTrend User’s Manual 

 
Please refer to the Technical Support web page for further assistance. 
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10 Software Set-up Preferences 

The SureTrend software set-up window is opened by selecting the Preferences option 
for the Set-up menu. The numerous set-up options are arranged into groups, and are 
explained in detail in the following sections: 
 

Options Group Section 
Password Protection 10.1 
General Options 10.2 
Time Format 10.3 
Date Format 10.3 
Report Set-up and Printing Options 10.4 
SystemSURE Unit Communications Options 10.5 
SureTrend Data File Options 10.6 

 
If any of the set-up options are modified, you must save the changes before they will 
take affect, by clicking the Apply button at the bottom of the Preferences window: 
 

 
 
NOTE: Certain set-up options require the SureTrend software to be restarted in order 
for their new setting to take affect. This is automatically performed when necessary. 
 

10.1 Password Protection 

The password protection options provide a level of Administrator control, to protect the 
SureTrend data from unauthorised or accidental modification and deletion: 
 

 
 

 Restrict Software Functions: Each of the following SureTrend software functions can 
be individually selected to prevent the user from modifying the results database, reports 
or unit set-up data: 
 

Function Protection Against Section 
 Data Synchronisation SystemSURE Unit data interchange  4.1 
 Database Text Editing Editing of database text fields 4 
 ‘Notes’ Field Editing Editing of any ‘Notes’ fields 2.2.3 
 Database Archiving Archiving of Database test results data 5 

 Archive File opening Importing of Archived test results data back 
into the Results Database 5 

 Data File Importing Importing of data files from other sites 2.4 
 Data Exporting Exporting of data  2.4.1 
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 Data File Deletion Deletion of any SureTrend data file  
 Report Set-up Creation or modification of report set-up files 6 
 Report Generation Generation of new report output 6 
 User ID Set-up Modification of the USER ID list 7 
 Unit Data Set-up Modification of Program and Test Plan data 8 

 
The associated protection password is set or changed by selecting the Password 
option from the Set-up menu: 
 

 
 
NOTE: If you forget the password, please contact your local distributor for assistance. 
 
Thereafter, attempting to perform any of the above protected software functions will 
display the following password dialog: 
 

 
 
TIP: The protected function can be temporarily unlocked (unprotected) by ticking the 
check box. The function can then be freely used without having to enter the password 
each time, and will become protected again next time the SureTrend software is run. 
 

10.2 General Options 

The following general set-up options are available: 
 

 
 

 Splash Screen: The SureTrend start-up splash screen can be disabled by unticking 
this check box. 
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10.3 Time and Date Format 

These options allow you to define the way in which times and dates are displayed: 
 

 
 
The format options are the same as those available on the SystemSURE unit: 
 

 AM/PM: Selects 12 Hour clock format (e.g. 9:41 PM) 
 24: Selects 24 Hour clock format (e.g. 21:41) 
 D/M/Y: Selects Date/Month/Year format (i.e.  DD/MM/YYYY) 
 M/D/Y: Selects Month/Date/Year format (i.e.  MM/DD/YYYY) 

 
TIP: The software can be set-up to automatically set the unit's internal clock to the 
current PC time and date, using the above time and date formats. Refer to section 10.5 
for details. 
 
10.4 Report Set-up and Printing Options 

The following general report set-up and printing options are available: 
 

 
 

 Standard Reports: The four quick-selection report toolbar buttons ( , ,  and ) 
can be configured to link to any of the Report set-up files, by selecting the report name 
from the appropriate drop-down list. 
 

 Report Page Header: By default, the words "SureTrend - Data Analysis Software" are 
printed at the top on each output page. This can be replaced with your Company Name, 
for example, or other text. 
 

 Shrink To Fit Page: When printing report data tables will lots of columns that would 
normally be too wide to fit on the printer paper, this option allows the output to be 
automatically reduced in size to fit the actual width of the paper. 
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10.5 SystemSURE Unit Communications 

The following unit communications options are available: 
 

 
 

 Attempt to Self-Connect: Tick this option to specific which PC serial port should be 
used to communicate with the SystemSURE unit and to automatically attempt to 
connect with the unit, without having to click the Connect button (see section 2.5). 
 

 Set Unit's Clock: Tick this option to automatically set the Unit’s internal real-time 
clock from the PC's clock and set the time and date format (see section 10.3) each time 
the software communicates with the unit. 
 

10.6 SureTrend Data Files Options 

The following data file options are available: 
 

 
 

 Data File Location: By default, all of the SureTrend data files are stored with in the 
software installation folder, under the Data Files sub-folder. This option can be used to 
specify an alternative location for these data files, such as a shared network drive. Refer 
to sections 1.1 and 2.3 for additional information and consideration. 
 

 Monitor Shared Files: Tick this option to automatically monitor the status of 'open' 
shared data files and prompt the user when the file has been changed by another user. 
 
NOTE: This feature can be troublesome when used with some networked file servers 
and operating systems (such as Windows 98). 
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11 Troubleshooting Tips 
 
This section lists typical problems that might be encountered when using this software, 
and their possible causes. 
 
For problems relating to the SystemSURE Unit, please refer to the Troubleshooting 
section in the SystemSURE Operator's Manual. 
 
Some problems and causes can be rectified by the operator, whilst others may require 
technical assistant: 
 

Severity Action Required 

 This indicates a cause which can be rectified by the user. 

 
This indicates a cause which may require technical 
attention for rectification. Contact your local distributor for 
further assistance. 

 
The following table lists typical symptoms and their possible causes. 
 

Symptom Possible Causes 
 
RS232 interface does 
not appear to be 
working 
 

 
 Wrong interface cable being used 
 Cable connector incorrectly inserted into unit 
 Cable connected to wrong serial port on PC 
 SureTrend software incorrectly installed or wrong options 
selected 

 Cable or connectors damaged or broken 
 PC serial port or system software faulty 
 Unit damaged or faulty  

 
 
Unable to read data 
from disk file 

 
 Wrong data file location specified (see section 10.6) 
 Data file is already open by another user 
 Data file has been moved or the disk removed 
 Data file has been deleted or has been corrupted 
 Disk drive is damaged or faulty 

 
 
Unable to write data to 
disk file or create a 
new data file 

 
 Wrong data file location specified (see section 10.6) 
 Disk drive or user does not have write permissions  
 Data file is already open by another user 
 Existing file is write protected 
 Disk drive is full 
 Disk drive is damaged or faulty 

 
 
Unit has an invalid 
serial number 

 
 SystemSURE unit memory fault (contact your local 

distributor for assistance) 
 

 
The Help file does not 
load 
 

 
 SureTrend software incorrectly installed (see section 1.1) 
 Adobe® PDF Reader is not installed on your PC 
 Help file is damaged or missing 
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12 Technical Specifications 
 

General: 
 
    Minimum PC system requirements 
 

Pentium series PC
1 RS232 port / adapter

    Recommended Operating System 
 

Windows XP (SP2)
512MB RAM

Results Database: 
 
    Maximum number of database records 
 

Unlimited *

Reports: 
 
    Maximum number of Report set-up files 
 

Unlimited *

    Maximum number of Filter Conditions 
 

Unlimited *

    Maximum number of Report output files 
 

Unlimited *

Unit Set-up Data: 
 
    Maximum number of SystemSURE Units 
 

Unlimited*

    Other limitations Refer to section 8.1
 
 

* Although these items have no imposed limit, PC processor speed, memory size 
and hard disk capacity will ultimately limit the overall performance and usability of 
the SureTrend software. 
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